
 

About This Guide 
 

Overview 
The PictureTel Live200 Product Guide describes Live200 windows, toolbars, and menus. It also defines the key 
terms you need to know to use Live200 and contains information about the Live200 preferences and hardware 
and communications settings. Review this online product guide before accessing Live200 to familiarize yourself 
with the product before you use it.  

 Step-by-step instructions about using Live200 operations, commands, and menu options are in the online help. 
Access the online help while using Live200 to immediately obtain the instructions you need to complete tasks.  

Click on the following links for more detailed information about:  

• Audience 
• Information Summary 
• Using Online Help 
• Reviewing the README File 

 

Audience 
The audience for this guide is the person who uses PictureTel Live200 for video, audio, and data conferencing 
calls. You should have a working knowledge of Microsoft® Windows®95 and how to use applications within 
the Windows 95 environment. 

 



Information Summary 
The PictureTel Live200 Product Guide includes the following information:  

• Live200 Components  
• Terminology 
• Live200 Calls 
• Navigation within Live200 Main Window  
• Navigation within Live200 Video Windows 
• Live200 Whiteboard, File Transfer, and Messaging applications  
• Live200 Address Book Lists 
• Application Sharing 
• Live200 Preferences  
• Troubleshooting  
• Hardware and Communication Settings 

 

Using Online Help 
Live200 provides quick and easy access to information about operations, commands, and menu options. Step-
by-step procedures on how to use all features of the Live200 system are documented in the PictureTel Live200 
online Help, which is available by any of the following methods:  

• Click the Help button in a window or dialog box.  
• Click your right mouse button on an item to access What's This Help. This type of help provides a brief 

pop-up window for a specific control or option in a window or dialog box.  
• Choose Help topics... from the Help menu in the Main toolbar to access the Live200 Help topics 

window. 

 

Reviewing the Release Notes 
The Release Notes file is a Notepad file that you can view online or print. The Release Notes document the 
most recent changes to Live200 1.5.  

 
 
 



Introducing PictureTel Live200 
 

Overview 
PictureTel Live200 is a personal videoconferencing system that lets you conduct meetings and share data with 
users of any H.320-compliant videoconferencing system. Live200 offers full-color, full-motion, live video and 
audio communications, as well as interactive information sharing. When you are not in a videoconference, you 
can use the Live200 board to access the Internet and gain remote access to other systems at speeds of 64 kbps or 
128 kbps.  

Click on the following topics for a description of  the PictureTel Live200 components and its compatibility with 
other desktop videoconferencing systems.  

• Software Component 
• Hardware Component 
• Video Camera 
• Audio Device 
• Optional Equipment 
• Compatibility 

 

Software Component 
PictureTel Live200 software runs under Microsoft Windows 95. It uses toolbars, pull-down menus, keyboard 
shortcuts, and other standard features of Windows 95 software. For step-by-step instructions on installing the 
software, see the PictureTel Live200 Installation Guide.  

 

Hardware Component 
The Live200 board gives your computer the specialized processing power it needs to send and receive live 
video images and audio signals. The Live200 board also provides the interface your computer needs to connect 
to a standard ISDN BRI (Basic Rate Interface) digital communication network. You can also purchase different 
network interfaces that connect to the Live200 board and give you access to other non-ISDN networks.  

For step-by-step instructions on installing hardware, see the PictureTel Live200 Installation Guide.  

 



Video Camera 
The Live200 video camera is a miniature color camera for the desktop environment. The camera mounts either 
on top of your computer monitor or on an overhead shelf, depending on your desktop requirements.  

 The camera has an up and down tilting base that lets you adjust its position. It automatically adjusts to a wide 
range of subjects and lighting conditions.  

 

Audio Device 
The Live200 system can be used with the single earpiece that has an attached microphone or the external 
microphone with multimedia speakers. You can also use speakers and a microphone from another manufacturer.  

 

Optional Equipment 
You can connect optional equipment, such as a speakerphone, to the Live200. You can also use the optional 
dual-input video cable to connect another video source, such as a document camera.  

 

Compatibility 
Desktop Videoconferencing Systems  

PictureTel Live200 is compatible with the following desktop videoconferencing systems:  

• PictureTel Live50 TM 
• PictureTel Live100 TM 
• PictureTel LiveLAN TM 

Group Videoconferencing Systems  
Live200 is compatible with the following group videoconferencing systems:  

• PictureTel System 1000 TM 
• PictureTel System 4000 TM 
• Venue·2000 TM 
• Concorde·4500 TM 
• SwiftSite TM  
• Data conferencing compatibility with PictureTel LiveShare Plus and PictureTel GroupShare. 

Note: See the README file for the release version numbers of the PictureTel products. 

You can also make video, audio, and data calls to other videoconferencing systems from various manufacturers 
based on the H.320 international standard.  



Live200 Calls 
 

 

Overview 
Live200 lets you connect with other users of any H.320-compliant videoconferencing system to communicate 
interactively in real-time. Using Live200, you can conduct meetings and share data with the other participants in 
the conference. You connect with the other users by dialing numbers to make calls, just like you do when using 
a telephone. Only Live200 lets you make different types of calls: video, audio-only, and data-only.  

The information in this section is organized into the following categories. Click on a category to obtain detailed 
information about it.  

• Video Calls 
• T.120 Multipoint Conference 
• Audio-Only Call 
• Data-Only Call 
• Answering a Call 
• Rejecting a Call 
• Adjusting your Ring Volume 
• Ending a Call 
• Call Log 

 

Video Calls 
Video calls enable each participant in the call to see each other in a window on their computer, to carry on an 
audible conversation, and to share onscreen data. With Live200, you can make point-to-point video calls and 
multipoint video calls.  

 Point-to-point calls are between you and one other participant. Multipoint calls are among you and several 
other attendees. All conference attendees can see and talk to each other. You and the other attendees set up a 
pre-arranged time for the conference and dial into a bridge, which hosts the conference.  

   

 

T.120 Multipoint Conference 
You can create a T.120 multipoint conference by clicking the Conference Wizard button or choosing 
Conference Wizard from the Call menu. The Conference Wizard guides you through the steps required to 
create a conference and invite attendees. It lets you save all of your conference settings and easily reconvene the 
same conference again later. You can also establish a multipoint conference by making choices from the Call 
menu and using the Dial Pad and the Address Book to identify attendees.  



Conferences that you create using the Dial Pad and Address Book are private. This means that other conference 
attendees cannot join the conference. Use the Conference Wizard if you want to create a public conference that 
other attendees can join.  

 

Audio-Only Call 
An audio-only call does not send your video image to other conference attendees but lets you talk back and 
forth. You make an audio-only call through the ISDN network transport.  

 

Data-Only Call 
A data-only call lets you share applications and the clipboard, use the Whiteboard as a common work area, 
transfer files, and send messages. You make a data-only call through the TCP/IP, NetBIOS, IPX, Modem, or the 
GroupShare network transport.  

 

Answering a Call 
You can choose to manually or automatically answer a call.  

 To manually answer a call:  

1. Click Answer Call in the Incoming Call dialog box. 

To automatically answer a call:  

1. Choose Preferences from the Tools menu.  
2. Select the Auto answer incoming calls checkbox in the Call tab of the Preferences dialog box. 

Note: If your system is set to automatically answer incoming calls, anyone can place a call to your site 
and interrupt a meeting in progress or look at equipment and whiteboard notes left in an empty room.  

 If the person calling you is listed in your address book list, the name of that person is identified in the Incoming 
Call dialog box (this is called Caller ID).  

 

Rejecting a Call 
If you do not want to answer a call, click Reject Call. The caller receives a message that you are not available 
to answer the call and the dialog box on your screen automatically closes when the caller hangs up.  

 



Adjusting Your Ring Volume 
Your computer notifies you by ringing when you have an incoming call. You can increase or decrease the 
volume of your computer's ring or turn it off.  

If you set up your computer to manually answer a call, and you turn off the ringer, you are alerted that you have 
an incoming call by the Incoming Call dialog box. If you set up your computer to automatically answer a call 
and you turn off the ringer, you cannot be alerted that you have an incoming call.  

 Note: You can adjust the ringer volume for external speakers, such as the multi-media speakers or the 
earpiece, through the Call Preferences tab but not for speakers that are internal to the PC. 

 

Ending a Call 
Click the Hang Up button in the Remote Video window or from the Main toolbar to end a call with other 
conference attendees. You can also wait until other conference attendees hang up. Once other conference 
attendees are disconnected, the call ends.  

 

Call Log 
The call log list automatically keeps track of every incoming and outgoing call that you make with PictureTel 
Live200. It does not log calls that fail to connect. The call log list displays information from the call log 
database about your incoming and outgoing calls. This information is displayed as individual entries in the Call 
Log dialog box.  

 Use the call log list to retrieve ISDN numbers that you need and might have forgotten. You can also compare 
your phone bill against the call duration times that appear in the call log list.  



 

 

To find a specific entry by last name, enter the person's last name in the Search on Last Name text field.  

To Remove an entry from the Call Log list, select the entry in the Call Log list and click Remove. To clear all 
call information from the call log database, click Clear Log.  

The Call Log list displays the following information:  

• Name of other conference attendees  
• ISDN number you dialed  
• Type of call (incoming or outgoing)  
• Date and time of the call  
• Duration of the call in hours, minutes, and seconds  

The View menu in the Call Log dialog box provides the following choices:  

 

• Incoming Calls displays only calls that you have received.  
• Outgoing Calls displays only calls that you have made to other conference attendees.  
• All Calls displays all calls that you received and made.  
• Close exits the Call Log dialog box.   



Navigating Within the Main Window 
 

Overview 
You navigate through the Live200 Main window by using the Main toolbar and menus. The Main window 
toolbar contains buttons that you can click to immediately access a function. These buttons provide a quick way 
of accessing a menu item. You can also use the Main toolbar menus to access all Live200 functions. 

Click the following lins for additional information: 

Main Toolbar 
Main Toolbar Buttons 
Additional Main Toolbar Buttons 
Status Line 
Call Menu 
Hotlist Menu 
Sharing Menu 
Tools Menu 
Window Menu 
Help Menu 
Image Bar 

 

Main Toolbar 
Once you start PictureTel Live200, the floating Main toolbar appears.  

 
The Main toolbar provides access to all of the Live200 functions. 

   

 

Main Toolbar Buttons 
The buttons on the Main toolbar are set with the default button settings. You can change and customize the 
Main toolbar buttons at any time. See Setting Preferences or the online help for instructions on customizing the 
Main toolbar  



 

The Make Call button lets you make a video, 
audio, or data call to other conference attendees 
over a phone line, network connection.  

 
The Hang up button disconnects a video, audio, or 
data call with other conference attendees. 

 

The Address Book button opens the Address Book 
window, which provides flexible telephone 
directories for storing phone numbers and other 
information about conference attendees. 

 

The Hotlist button provides a speed-dialing list for 
your most frequently called phone numbers. It also 
contains the most recently dialed numbers. 

 

The Local Video button opens the Local Video 
window, which displays the image that you are 
sending to other conference attendees and brings it 
to the top. 

 

The Remote Video button opens the Remote Video 
window, which displays the image that other 
conference attendees are sending you and brings it 
to the top. 

 

The Audio/Video Mute button turns off both the 
microphone and the camera so other conference 
attendees cannot hear or see you. A red circle 
superimposed on the button means off. 

 

The Whiteboard button lets you open the 
Whiteboard prior to making a video call to prepare 
a presentation or a word processing file. You can 
also open the Whiteboard during a video call using 
the toolbar in the Remote Video window or the 
Main toolbar. 

 

The Conference Wizard button lets you create a 
data-only conference that includes yourself and one 
or more additional attendees and save its settings for 
future use. 

 
The Help button opens the Help Contents window, 
which provides help on Live200 features. 

 



Additional Main Toolbar Buttons 
You can add the following buttons to the Main toolbar using the Toolbar tab in the Preferences dialog box. See 
the online help or Setting Preferences  for more information.  

 

The Eject Attendee button lets you disconnect a 
conference attendee (only if you established the 
conference).  

 

The Audio Off button lets you turn off your 
microphone so that other conference attendees 
cannot hear you or local conversations. A red circle 
means off. 

 

The Video Off button lets you turn off the video 
image so that other conference attendees cannot see 
you. A red circle means off. 

 

The File Transfer button opens the File Transfer 
window, which lets you send files to other 
conference attendees. 

 

The Message button opens the Message window, 
which lets you send and receive messages during a 
call.  

 
The Share Application button lets you share an 
application or file with other conference attendees.  

 

The Unshare Application button lets you stop 
sharing an application that you are currently 
sharing. You cannot unshare an application that 
another conference attendee set up to share. When 
you unshare an application, it disappears from the 
other conference attendees' desktops but remains 
open on your desktop.  

 

The Share - Work Alone button lets you disable 
application sharing while retaining your view of 
shared applications.  

 

The Control Remote Desktop button lets you 
remotely control the desktop of any product with 
LiveShare Plus.  

 
The Clipboard button lets you copy and paste data 
f t t th b h i th



standard Windows clipboard.  

 

The Clipboard Viewer button opens the Windows 
95 Clipboard viewer. This lets you preview data 
copied to the clipboard.  

 

The Context-Sensitive Help button turns your 
pointer into a help icon that you can use to get help 
on Live200 functions.  

 

The Hardware Settings button opens the Hardware 
Settings window, which lets you change your audio, 
video, audio compression, video compression, 
network, and application sharing settings. You can 
also view information about the Live200 board, 
such as revision levels.  

 

The Call Log button opens the Call Log window, 
which provides historical information about 
incoming and outgoing calls.  

 

The Diagnostics button opens the Diagnostics 
dialog box, which lets you test your software and 
view call statistics.  

 

The Communications button opens the 
Communications window, which lets you enable, 
disable, and reconfigure network transports.  

 

Status Line 
The Status Line in the Main toolbar provides information about the current status of your Live200 system.  

 

Call Menu 
The Call menu provides the following options:  

• Make call opens the Make Call dialog box, which lets you make a video, audio, or data call to other 
conference attendees. 

• Hang up disconnects a video, audio, or data call with other conference attendees. 
• Eject Attendee disconnects a conference attendee (only if you established the conference). 



• Address Book opens the Address Book window, which provides flexible telephone directories for 
storing phone numbers and other information about conference attendees. 

• Conference Wizard lets you create a data conference and save its settings for future use. 
• Exit closes the Live200 application. 

 

 

Hotlist Menu 
The Hotlist menu lets you speed-dial a list of frequently-called phone numbers and access previously dialed 
numbers.  

• Add to Hotlist adds a conference attendee's name and phone number to the Hotlist menu.  
• Remove from Hotlist removes a conference attendee's name and phone number from the Hotlist menu. 
• Most recently dialed numbers appear on this menu. 

 

 

Sharing Menu 
The Sharing menu provides the following options:  

• Whiteboard opens the Whiteboard application so you can edit a presentation or a word processing file 
with other conference attendees.  

• File Transfer lets you send files to other conference attendees.  
• Message lets you send and receive messages during a call.  
• Share Application lets you share any Windows 95 application with other conference attendees. When 

you share an application, it appears on the desktops of the other conference attendees.  
• Unshare Application lets you end sharing of a currently shared application. When you unshare an 

application, it disappears from the desktops of the other conference attendees, but remains open on your 
desktop.  

• Share - Collaborate re-establishes application sharing and lets other conference attendees interact with 
shared applications.  

• Share - Work Alone removes the application sharing link and lets you work independently, without 
affecting the actions or views of the other conference attendees.  



• Control Remote Desktop lets you remotely access another PictureTel LiveShare Plus user's desktop. 
You can control the remote desktop just as if you were using that system's keyboard and mouse.  

• Share Clipboard lets you transfer data to another computer. You and the other conference attendees can 
cut, copy, or paste data into or out of the Windows 95 Clipboard.  

• Clipboard Viewer opens the Windows 95 Clipboard viewer. This lets you preview data copied to the 
Clipboard.  

Note: The Clipboard Viewer is installed when you load Windows 95. If the Clipboard Viewer is 
not available in the Sharing menu, then the Clipboard Viewer did not get installed. 

 

 

Tools Menu 
The Tools menu provides the following options:  

• Preferences lets you customize the Live200 working environment.  
• Communications lets you enable, disable, and reconfigure network transports.  
• Hardware Settings let you change your audio, video, audio compression, video compression, network, 

and application sharing settings. You can also view information on the Live200 board, such as revision 
levels.  

• Call Log keeps a record of incoming and outgoing calls such as the name of the conference attendee, 
date, time, and duration of the call.  

• Diagnostics lets you test your software and view call statistics. 

 

 



Window Menu 
The Window menu provides the following options:  

• Local Video lets you open the Local Video window, which displays the video image you are sending to 
your calling partner. 

• Remote Video lets you open the Remote Video window, which displays the video image your calling 
partner is sending to you. 

 

 

Help Menu 
The Help menu lets you access online help for all Live200 functions, and provides the version number of the 
program.  

 

 

Image Bar 
The Image Bar appears under the Main toolbar during a video call and a data-only call, if the other conference 
attendees' systems support the T.120 multipoint standard. If you are in a conference with a system that does not 
support this standard, you only see the Main toolbar.  

<- Image Bar 



Navigating Within the Video Windows 
 

Overview 
You navigate through the Video windows by using toolbars and menus. The toolbars contain buttons that you 
can click to immediately access a function. These buttons provide a quick way of accessing a menu item. You 
can also use the toolbar menus to access Video windows functions.  

Click the following links for additional information:  

• Local Video Window 
• Local Video Camera 
• WorldCam 
• FlipCam 
• Local Video Window Toolbar 
• Snapshots 
• Additional Local Video Window Toolbar Buttons 
• Local Video Window Menus 
• Remote Video Window 
• Remote Video Camera 
• Remote Video Window Toolbar 
• Additional Remote Video Window Toolbar Buttons 
• Remote Video Window Menus 
• Arranging Your Video Windows 
• Selecting the Video Source 
• Turning Off Your Video Camera 
• Adjusting Your Audio Level 

 

Local Video Window 
The window that displays the video image you are sending to the other conference attendees is called the Local 
Video window. You can view the image that you are sending before and during a video call.  



 

 

Local Video Camera 
You send a video image to other conference attendees by using the local video camera, like a WorldCam, 
FlipCam, or any other type of video camera. You can also use Live200's optional dual-input video cable to 
connect another video source, such as a document camera.  

You can tilt the camera to center the image you are sending. If you are using a camera that does not have 
control buttons on it, you can increase or decrease the brightness level of your video image using the buttons in 
the Local Video window toolbar. You can also adjust the color and contrast levels by adding these buttons to 
the Local Video window toolbar or by adjusting their sliders using the Video tab of the Hardware Settings 
dialog box.  

You can also make adjustments from the Windows 95 Control Panel. See Changing Your System Settings in the 
online help for information.  

 

WorldCam 
If you are using the WorldCam camera, adjust the focus using the Focus knob on the camera. You increase or 
decrease the brightness level of the image using the Contrast buttons on the camera. It is recommended that you 
keep the brightness and contrast sliders in the Video Settings sheet at the default positions and adjust the video 
image using the controls on the WorldCam.  

When you turn on the WorldCam, it powers up in manual exposure mode. For most videoconferencing 
situations, manual mode is preferred. However, you can switch the camera to automatic exposure mode by 
pressing the two Contrast buttons at the same time. Pressing the Contrast buttons switches the camera between 
manual and automatic mode. When the camera is in automatic mode, it compensates for large variations in 
lighting. However, this can slow down the video frame rate and decrease the quality of the video image. It is 
recommended that you operate the WorldCam in manual mode for the optimum video image.  



 

FlipCam 
If you are using the FlipCam camera, adjust the focus lever marked  to sharpen the focus. To widen or 
narrow the camera's field of view, adjust the zoom lever marked . When you change the zoom setting, you 
usually must refocus as well. To lighten or darken the picture, adjust the brightness (iris) lever, marked .  

 

Local Video Window Toolbar 
You can use the following buttons in the Local Video window toolbar to immediately access a feature. Each 
button is a shortcut way of choosing a menu item.  

Toolbar Description  

 

The Image Size box lets you automatically resize the Local Video window. The 
choices are Small, Medium, and Large. If you manually resize this window by 
dragging the bottom right-hand corner, the window dimensions are displayed in 
the box. You can also set the default sizes for Small, Medium, and Large in the 
Video Window sheet from the Preferences dialog box. 

 
The Increase Brightness button increases the balance of light and dark shades of 
your image in the Local Video window. 

 
The Decrease Brightness button decreases the balance of light and dark shades in 
the Local Video window. 

 
The Snapshot button lets you take a still image, similar to an electronic 
photograph and displays it using the Windows Paint application.  

 

The Select Video Source button lets you choose which local video source you 
want to send. For example, you might want to use another camera to focus in on 
the details of a document. This button lets you select the document camera as the 
video source. 

 

Snapshots 
A snapshot is a high-resolution, still image, similar to an electronic photograph. You can take a snapshot from 
the Local and Remote Video windows and include the snapshot in the Address Book. When you are in a video 
or data conference and Caller ID is supported, the conference attendee's snapshot appears on the Image Bar. A 
default image appears for attendees whose snapshot is not stored in the Address Book.  

When you click the Snapshot button the current image in the window is captured as a still image and is 
displayed in the Windows 95 Paint application. Each time you click the Snapshot button or choose Snapshot 
from the menu, a window appears displaying the new snapshot.You can edit the snapshot using the Paint editing 
tools.  

 



Additional Local Video Window Toolbar Buttons 
You can add the following buttons to the Local Video window toolbar using the Toolbar sheet in the 
Preferences dialog box. See the online help or Setting Preferences for more information.  

Toolbar Description 

 
The Increase Contrast button increases the range between the lightest tones and 
the darkest tones of your image in the Local Video window. 

 
The Decrease Contrast button decreases the range between the lightest tones and 
the darkest tones of your image in the Local Video window. 

 
The Increase Color button increases the color mixture of your image in the Local 
Video window. 

 
The Decrease Color button decreases the color mixture of your image in the Local 
Video window. 

 

Local Video Window Menus 
You can use the menu bar within the Local Video window to access the following menus:  

Menu Description 

 

The Image menu provides the following options that let you change the 
size of the Local Video window:   

• Small  
• Medium  
• Large  

You can also change the size of the Local Video window by dragging the 
lower right-hand corner of the window border. Live200 provides an aspect 
ratio similar to your monitor's aspect ratio. The aspect ratio is the 
relationship between width and height. 

 

The Camera menu provides the following options:   

• Snapshot takes a snapshot of the image in the Local Video 
window.  

• Select Video Source lets you select the video source to use during 
a call.  

• Move Remote Camera lets you adjust the remote camera if it has 
pan/tilt/zoom (PTZ) capabilities.  

 



Remote Video Window 
The window that displays the video image of the other conference attendee is called the Remote Video window. 
Once you are connected, and the conference attendee answers your call, the Remote Video window appears on 
your PC.  

 

When you are in a multipoint conference, the image in the Remote Video window switches to the conference 
attendee who is currently speaking. If you close the Remote Video window during a video call, a dialog box 
appears telling you that the window is closing; however, the video call is not disconnected  

You can change the size of the Remote Video window by dragging the lower right-hand corner of the window 
border.  

 

Remote Video Camera 
If you are calling a system that supports remote camera control, such as a PictureTel group system, you can 
adjust the remote camera, provided the camera has pan/tilt/zoom (PTZ) capabilities.  

You can use the Remote Camera Control Preset buttons to associate the remote camera position with a 
button. For example, if you are in a conference where you are using a whiteboard to present information, you 
can preset a button so that when it is clicked, the camera focuses on the whiteboard. This saves time since you 
do not have to adjust the camera in the middle of the conference.  

The preset locations are saved on the remote video camera, not on your PC. Therefore, it is possible for another 
conference attendee to change the settings for a preset number that you might have set during the current 
conference or a previous conference. If you are in a conference with a group system, it is also possible that your 
ability to change the remote camera's preset number buttons might be disabled. The Remote Camera Control 



Preset buttons do not appear in the Remote Video Window if the remote system does not support remote camera 
control or has disabled it.  

 

Remote Video Window Toolbar 
You can use the following buttons in the Remote Video window toolbar to immediately access a feature. Each 
button is a shortcut to choosing a menu item.  

Toolbar Description 

 

The Image Size box lets you automatically resize the Remote Video window. 
The choices are Small, Medium, and Large. If you manually resize this window 
by dragging the bottom right-hand corner, the window dimensions are displayed 
in the box. You can also set the default sizes for Small, Medium, and Large in 
the Video Window sheet from the Preferences dialog box. 

 
The Hang up button disconnects a video, audio, or data call with other 
conference attendees. 

 
The Audio Off button lets you turn off the microphone so that other conference 
attendees cannot hear you or local conversations. A red circle means off. 

 

The Video Off button turns off the video image so that other conference 
attendees cannot see you. When you turn off your video the image in the Local 
Video window is black. A red circle means off. 

 
The Snapshot button takes a still image, similar to an electronic photograph and 
displays it using the Windows Paint application. 

 

The Remote Camera Control button lets you pan, tilt, and zoom the remote 
camera when calling a remote system that supports remote camera control, such 
as a PictureTel group system. 

 
The Whiteboard button opens the Whiteboard application so you can annotate a 
presentation or a word processing file with other conference attendees.  

 
The Share Application button lets you share an application or file with other 
conference attendees. 

 

The Unshare Application button lets you stop sharing an application that you 
are currently sharing. You cannot unshare an application that another conference 
attendee set up to share. When you unshare an application, it disappears from the 
other conference attendees' desktops but remains open on your desktop. 

 
The Volume control slider lets you adjust the volume of the audio that you are 
receiving from the other conference attendees. Sliding the control to the left 
decreases the volume. Sliding the control to the right increases the volume. 

 
The Call duration counter records the length of time of your call by displaying 
the hours, minutes, and seconds. 

 

The Remote Camera Control preset buttons appear when the camera at the far 
end has pan\tilt\zoom (PTZ) capabilities. You can associate a remote camera 
position with a button. When you click a preset button the camera automatically 
focuses on the position that you set. 

 



Additional Remote Video Window Toolbar Buttons 
You can add the following buttons to the Remote Video window toolbar using the Toolbar sheet in the 
Preferences dialog box. See the online help or Setting Preferences for more informations.  

Toolbar Description 

 
The Audio/Video Mute button turns off both the microphone and the camera so 
that other conference attendees cannot hear or see you. 

 

The Select Video Source button lets you choose which remote video source you 
want to receive. For example, a conference attendee might want to use another 
camera to focus in on the details of a document. This button lets you choose a 
document camera as the remote video source, if you have one connected. 

 
The File Transfer button opens the File Transfer window, which lets you send files 
to other conference attendees. 

 
The Message button opens the Message window, which lets you send and receive 
messages during a call. 

 
The Clipboard button lets you copy or paste data from one computer to another by 
sharing the Windows Clipboard. 

 
The Clipboard Viewer button opens the Windows 95 Clipboard viewer. This lets 
you preview data that has been copied there. 

 
The Share - Work Alone button lets you disable application sharing while 
retaining your view of open applications. 

 
The Control Remote Desktop button lets you remotely control a desktop of 
another PictureTel LiveShare Plus user. 

 

Remote Video Window Menus 
You can use the menu bar within the Remote Video window to access the following menus:  

  

 

The Call menu provides the following options:   

• Hang up disconnects a video, audio, or data call with other 
conference attendees.  

• Audio Off turns off the microphone so that other conference 
attendees cannot hear local conversations.  

Video Off turns off the video image so that other conference 
attendees cannot see you.  



 

The Sharing menu provides the following options:   

• Whiteboard opens the Whiteboard application so you can edit a 
presentation or a word processing file with other conference 
attendees.  

• File Transfer lets you send files to other conference attendees.  
• Message lets you send and receive messages during a call.  
• Share Application lets you share any Windows 95 application 

with other conference attendees. When you share an application, 
it appears on the desktops of the other conference attendees.  

• Unshare Application lets you end the sharing of a currently 
shared application. When you unshare an application, it 
disappears from the desktops of the other conference attendees, 
but remains open on your desktop.  

• Share - Collaborate re-establishes application sharing and lets 
other conference attendees interact with shared applications.  

• Share - Work Alone removes the application sharing link and 
lets you work independently, without affecting the actions or 
views of the other conference attendees.  

• Control Remote Desktop lets you remotely access another 
PictureTel LiveShare Plus user's desktop. You can control the 
remote desktop just as if you were using that system's keyboard 
and mouse.  

• Share Clipboard lets you transfer data from one computer to 
another computer. You and other conference attendees can cut, 
copy, or paste data into or out of the shared Windows Clipboard.  

Clipboard Viewer opens the Windows 95 Clipboard viewer. 
This lets you preview data that can be shared.  

 

The Image menu provides the following options that let you change the 
size of the Remote Video window:   

• Small  
• Medium  
• Large  

You can also change the size of the Remote Video window by dragging 
the lower right-hand corner of the window border. 

 

The Camera menu provides the following options:   

• Snapshot takes a snapshot of the image in the Remote Video 
window and displays it in the Windows 95 Paint application.  

• Select Video Source lets you select the video source to use 
during a call.  

• Move Remote Camera lets you adjust the remote camera, 
provided the camera has pan/tilt/zoom (PTZ) capabilities.  

 



Arranging Your Video Windows 
You can resize and save the position of the Local and Remote Video windows. You can automatically resize the 
windows by selecting either Small, Medium, or Large from the Image Size box in the Local Video or Remote 
Video windows. You can manually resize the windows by dragging the lower right-hand corner of the window 
border.  

You can save video window positions as the default locations that appear each time you run PictureTel Live200. 
You can save the window positions through the Video Window tab of the Preferences dialog box.  

 

Selecting the Video Source 
You can select the video source you want to use during a call by clicking the Select Video Source button or 
choosing Select Video Source from the Camera menu in the Local Video or Remote Video windows. When 
you are in the Local Video window, you can select the local video source. When you are in the Remote Video 
window, you can select the remote video source. For example, you might want to switch to a document camera 
during the conference.  

 

Turning Off Your Video Camera 
You can turn off your video camera by clicking the Video Off button or choosing Video Off from the Call 
menu in the Remote Video window. If you are using the WorldCam or the FlipCam, you can also close the 
privacy shutter on the front of the camera so that the other conference attendees cannot see your image.  

 

Adjusting Your Audio Level 
You can adjust the audio level you receive from other conference attendees by clicking the volume control 
in the Remote Video window. You can turn off the audio you are sending by clicking the Audio Off button 
in the Remote Video window or by clicking Audio Off from the Call menu. 



Using the Live200 Applications 
 

Overview 
Live200 contains three applications you can use during conferences:  

• Whiteboard application. 
• File Transfer application. 
• Messaging application. 

You use the Whiteboard before a call to prepare word processing files or a presentation, or during a call with 
other conference attendees. The File Transfer function lets you and other conference attendees send or receive 
files and folders to and from each other. When you transfer a file or folder, it is sent to all conference attendees. 
The Message application lets you and other conference attendees create and exchange a written record or your 
conference call.  

 

Whiteboard 
The Whiteboard is an online visual work space that you and the other conference attendees can see and use 
together in the same way you use a traditional whiteboard or an overhead projector. You use the Whiteboard 
application to share and annotate documents, presentations, or graphics during a call with other conference 
attendees. You can capture documents and import graphics into the Whiteboard and superimpose your edit 
marks on the page using the Whiteboard markup tools.  

   

 



Whiteboard Toolbar 
The Whiteboard toolbar provides access to all Whiteboard tool functions.  

 
The Select tool lets you select an object in the Whiteboard to move, copy, cut, 
delete, or paste.  

 
The Draw tool lets you create geometric shapes on top of an object using a choice 
of lines and widths, and colors.  

 
The Highlight tool lets you draw translucent lines on top of an object in the 
Whiteboard. 

 
The Text tool lets you superimpose text on a captured document or an imported 
graphic file.  

 

The Remote Pointer tool lets you and other conference attendees point to an object 
in the Whiteboard. Your pointer is blue if you made the call, or yellow if you are 
receiving an incoming call.  

 
The Zoom tool lets you magnify your screen for closer scrutiny of an object. 

 
The Grab Area tool lets you capture a selected area on the Windows 95 desktop 
for copying into the Whiteboard.  

 
The Grab Window tool lets you capture any window on your Windows 95 desktop 
for copying into the Whiteboard. You can even capture the entire desktop.  

 
The Lock Contents tool lets you prevent other conference attendees from making 
any changes to the Whiteboard.  

 
The Synchronize tool refreshes your screen and other conference attendees' screens 
to ensure you are all working with the same information at the same time. 

 
The Scan tool lets you scan images from TWAIN-supported scanners and video 
capture devices into the Whiteboard. 

 



Whiteboard Shortcut Menu 
You access the Whiteboard toolbar functions from a shortcut menu (or from the Tools menu). The Page Sorter 
command is also available from the Edit menu  

 .  

 To use the shortcut menu:  

1. Move your cursor into the editing area of the Whiteboard.  
2. Click the right mouse button.  
3. Choose the menu command you want to use. 

 

File Transfer 
The File Transfer application lets you send or receive files during a conference. You can send files to all 
conference attendees simultaneously. The File Transfer application supports the ITU T.127 Multipoint Binary 
File Transfer Protocol, which enables you to send and receive files with any application that supports T.127, 
such as Intel ProShare and Microsoft NetMeeting.  

 

File Transfer Outbox 
The File Transfer function lets you and other conference attendees send or receive files and folders to and from 
each other. When you transfer a file or folder, it is sent to all conference attendees.  



 

 

File Transfer Inbox 
When another conference attendee sends you a file, the Inbox changes to indicate you have received a file. The 
Inbox is a Windows 95 Explorer window and shows all files that have been sent during the conference and 
previous conferences.  

Note: Before receiving files from other conference attendees, find out what the size of the file is so that 
you can ensure you have enough disk space for a proper transfer. 

 

   

 

File Transfer Toolbar 
The File Transfer toolbar provides access to all File Transfer functions.  

  



 

Messaging 
The Message application lets you and other conference attendees create and exchange a written record of 
discussion topics, decisions, action items, and outstanding issues that are raised during a call. It is a 
communications tool that you and other conference attendees can use for sharing and distributing meeting 
minutes during a call. It can also be saved for sharing with colleagues that do not attend a call.  

 

Messaging Window 
The Message window lets you and other conference attendees record discussion topics, minutes, and action 
items.  

 

 

Messaging Toolbar 
The toolbar in the Message window lets you customize how messages are 

displayed.   

 



Address Book Lists 
 

Overview 
Address book lists are flexible telephone directories that let you automatically make calls without having to 
manually dial numbers. You can create one or more address book list. Each list contains entries that have a 
conference attendee's name, address, phone number, and other connection information. 

Click the following links for additional information: 

• Address Book Window 
• Converting Live50/100 Address Book Lists 
• Address Book Toolbar 
• Add Person Window 
• Connections Information 
• Address Book List Dialog Box 
• Hotlists 

 

Address Book Window 
The PictureTel Address Book window displays your first and last name, and ISDN number the first time you 
open it. 



 

After you open the Address Book window, you can create an address book list and start adding entries. 
Information on a specific conference attendee in an address book list is called an entry. Each address book list 
can have an unlimited number of entries. Address book lists are given a .PTA extension and are stored in the 
location you specify. If you want Caller ID to identify incoming calls, the number must be listed in an address 
book list.  

Although the primary purpose of the Address Book is to store numbers and connect to other conference 
attendees, you can also use it as your central telephone directory for all your contacts. You can store an address 
book list as a shortcut on your Windows 95 desktop or on a shared network drive. 

 

Converting Live50/100 Address Book Lists 
You can convert address book lists from your Live50/100 systems to the Live200 format using the ABconverter 
program located in the \Program Files\PictureTel\LiveWare directory. Double-click the ABconverter icon and 
follow the instructions on the screen. 

 

Address Book Toolbar 
You can use the following buttons in the toolbar of the Address Book window to immediately access a feature. 
Each button is a shortcut way of choosing a menu item.  



 The New button creates a new address book list.  

 The Open button opens an existing address book list.  

 The Print button prints the contents of an address book list.  

 The Add New Person button lets you add a new entry to an address book list. 

 

Add Person Window 
When you add a new person to your Address Book, you enter their information in the Add Person window. If 
you include a snapshot of the person in the Name sheet and Caller ID is supported, that snapshot appears on the 
Image Bar during a call. 

 

 

Connections Information 
The connection type you choose determines the additional connection information you enter. For ISDN and 
modem connections you enter phone numbers. For TCP/IP, NetBIOS, or IPX connections, you enter addresses. 
You can add more than one connection per entry. For example, your caller might have a residential as well as a 
business ISDN line, or a local and overseas ISDN line. You might also want to add a connection using another 
network transport, such as TCP/IP. 



If you are using dialing prefixes, you do not need to enter them here. You specify dialing prefixes in the Call tab 
of the Preference dialog box. 

 

 

Address Book List Dialog Box Toolbar 
You can use the following buttons in the toolbar of the Create and Open Address Book List dialog boxes to 
immediately access a feature. Each button is a shortcut way of choosing a menu item. 

These buttons are also available in the Create New Address List window, which is described in the next section.  

Icon Description 

 The Up One Level button displays the directory level above the currently displayed level.  

 
The Create New Folder button creates a folder in which you can store an address book list. You can 
specify a path and a descriptive name for a folder.  

 
The List button displays only the file names of address book lists in the Create and Open Address 
List dialog boxes.  

 
The Details button displays the Size, Type, and Modified date of each address book list in the Create 
and Open Address List dialog boxes.  

 



Hotlists 
You can create a list of your most frequently dialed conference attendees using the Hotlist menu. You can 
then automatically speed-dial a call to a conference attendee by clicking the Hotlist button or choosing 
Hotlist from the Main toolbar and clicking the number from the hotlist. You can set the number of entries 
that appear in the Hotlist menu from the Call tab of the Preferences dialog box. 

 



Application Sharing  
 

Overview 
PictureTel Live200 lets you and other conference attendees share applications while in a call. With application 
sharing, you and the other conference attendees work with the same application just as if you were working at 
the same computer. An exact copy of the application window appears on all machines, even if the application is 
not installed on those machines. Live200 allows you to share as many applications as you like during a 
conference. 

Click the following links for additional information: 

• Application Sharing Tips 
• Working with Shared Applications 
• Application Scrolling 
• Unsharing an Application 
• Working Alone 
• Re-establishing Application Sharing 
• Control Remote Desktop 
• Sharing the Clipboard 
• Launching the Clipboard Viewer 

 

Application Sharing Tips 
Follow these guidelines when sharing applications: 

• Use the same screen resolution as the other conference attendees. Use the highest resolution supported 
by your graphics board. If using the same resolution is not possible, use the automatic scrolling feature 
in the Share sheet of the Preferences dialog box.  

• Share only as many applications as necessary. Shared windows that are not in use can be distracting and 
it might be difficult to tell which party is in control.  

• Clear your desktop of unneeded windows and icons. Working together on shared applications is easiest 
if everyone can see only the shared windows.  

• Work carefully and deliberately, especially when you describe a task that you are performing. Give the 
other conference attendees time to see the changes you make.  

• Alternate control in an orderly fashion. Only one person can have control at any one time. Tell the other 
conference attendees when you are taking control.  

• Clear the Main toolbar always on top checkbox in the General tab of the Preferences dialog box. If the 
Main toolbar is on top, it can block another person's view of a shared window. 

Live200 uses 256 colors when sharing an application. 

 



 
Working with Shared Applications 
In general, shared applications behave much the same way as other applications. However, with a shared 
application, the commands you select and tasks you perform actually take place on the system where the 
application resides. For example, files are saved and printed on the system running the shared application. One 
attendee controls each shared application at any one time while the other attendees watch.  

To access the shared application, the other conference attendees must enable Share - Collaborate from the 
Sharing menu. 

As soon as another conference attendee presses the left mouse button or touches a key on the keyboard, control 
transfers to that attendee and your status bar indicates that you are no longer in control. 

 

Application Scrolling 
The Application Scrolling feature automatically scrolls a window to follow the mouse pointer. This feature is 
useful if you and other conference attendees have different screen resolutions, which causes sizing 
incompatibilities when sharing applications. 

For example, your screen is 1024 x 768 pixels, but another conference attendee's screen is 640 x 480 pixels. A 
window that fits in one quarter of a 1024 x 768 screen fills almost all of a 640 x 480 screen. In this scenario, 
you have a larger desktop area than another conference attendee; therefore, you can see more on the screen. 

If you are in control and you move your mouse pointer to a part of the window that is off another conference 
attendee's screen, Live200 automatically scrolls the window on the conference attendee's screen to follow the 
mouse pointer. 

To set the application scrolling feature: 

1. Click Preferences from the Tools menu in the Main toolbar.  
2. Click the Share tab.  
3. Choose one of the following options:  

• Scroll the shared application on my screen: The shared application appears in a window that is 
smaller than the application window. Choose this option if you want the application to scroll as you 
move the cursor near the edges of the application window.  

• Scroll the entire screen: The entire desktop scrolls. Choose this option if you want to keep all 
application windows in the same relative positions on your desktop. Your entire desktop scrolls along 
with the shared application window.  

• Clip off the edges of the application on my screen: The shared application appears in a small window 
with the edges clipped off. Choose this option if you do not want the application to scroll as you move 
the cursor near the edges of the application window. When you are in control, you might need to drag or 
resize the window to reach various areas.  

 



Unsharing an Application 
Only the attendee who originally shared an application can unshare that application. When you unshare an 
application, it disappears from other conference attendees' desktops but remains open on your desktop, and 
application sharing is stopped. When you want to unshare an application, take control by clicking the left mouse 
button, click the Unshare Application button or choose Unshare Application from the Sharing menu, and 
click in the application window. 

 

Working Alone 
The Work Alone feature lets you disable application sharing while retaining your view of open applications. 
Working alone suspends the application sharing link, and lets you and other conference attendees work 
independently without affecting each others actions or views. 

Disabling application sharing ensures a shared application remains accessible while you switch tasks. For 
example, you and other conference attendees might begin working with a shared application when one of you 
wants to work on another area of the desktop. 

When you want to work alone during an application sharing session, take control by clicking the left mouse 
button, click the Share - Work Alone button, or choose Share - Work Alone from the Sharing menu. 

To work alone when you are viewing and another conference attendee is in control of the cursor and keyboard, 
press the Escape key or click your right mouse button. 

 

Re-establishing Application Sharing 
You can re-establish application sharing by choosing Share - Collaborate from the Sharing menu in the 
Remote Video Window. 

 

Control Remote Desktop 
The Control Remote Desktop feature lets you access another PictureTel user's desktop from your computer. 
Once you are connected, you can access the applications and files on the remote computer. You can also use 
this feature to access your office desktop from your home computer providing you have the appropriate network 
connection. 

To control a remote desktop, you must first set up the remote computer correctly. Refer to the online Help for 
instructions about how to set up a remote computer so that it can be remotely controlled and how to set up your 
computer to allow remote control. 

You can prevent another PictureTel user from controlling your desktop from a remote location. Turning off 
remote control keeps other callers from using your applications, even if they are able to connect. You can also 
deselect Auto answer incoming calls if you do not want callers to connect unless you are there to answer. 



You can control a remote system only if you are in a point-to-point call; you cannot use this feature in a 
multipoint call. 

 

Sharing the Clipboard 
You can share data from one computer to another computer using the clipboard. You and other conference 
attendees can copy, cut, and paste data into and out of the clipboard, regardless of which person originally 
stored the information there. Only one piece of data can be stored in the clipboard at a time. To share the 
clipboard, you click the Clipboard button or choose Share Clipboard from the Sharing menu in the Main 
toolbar or the Remote Video window. A checkmark appears next to the Share Clipboard menu command once 
you choose it. 

When you unshare the clipboard, the information you store cannot be shared with other conference attendees. 
To unshare the clipboard, you choose Share Clipboard from the Sharing menu in the Main toolbar or the 
Remote Video window. The checkmark is removed from the Share Clipboard menu command. 

 

Launching the Clipboard Viewer 
You can launch the clipboard viewer to preview data before you share it with another conference 
attendee.To launch the clipboard viewer, click the Clipboard Viewer button or choose Clipboard Viewer 
from the Sharing menu in the Main toolbar or the Remote Video window. 



Setting Preferences 
 

Overview 
PictureTel Live200 preference settings let you customize the program's working environment. For example, you 
can customize toolbars by adding the buttons that you use the most. Once you select your preferences, they 
remain in effect from one calling session to the next, until you change them. 

Click the following links for additional information: 

• Preferences Dialog Box 
• General Preferences 
• Call Preferences 
• Share Preferences 
• Conference Preferences 
• Video Window Preferences 
• Video Windows and Application Sharing 
• Toolbar Preferences 
• Customizing the Toolbars 
• Spacing between Toolbars 
• Local Video Window Toolbar 
• Remote Video Window Toolbar 
• Menu Preferences 

 

Preferences Dialog Box 
Choose Preferences for the Tools menu in the Main toolbar or click the Preferences button (if you added this 
button to the toolbar). 



 

The Preferences dialog box provides access to the General, Call, Share, Conference, Video Window, Toolbar 
and Menu Preferences sheets. 

 

General Preferences 
Click the General tab to display the General Preferences sheet. General preferences let you: 

• Retain windows sizes and positions  
• Position the PictureTel Live200 Main toolbar  
• Set the preferences for Caller identification 



 

The following General Preferences are available from the Windows group: 

• Save window positions and size between sessions lets you save the window sizes and positions from 
the last time you accessed the Live200 application. The default setting is On.  

• Main toolbar always on top prevents other windows from covering the main toolbar. The default 
setting is Off. Caller identification identifies incoming calls with the name of the caller if the caller is 
listed in an Address Book list. The caller's name appears in the: 

• Remote Video window (if the call is a video call)  
• Image Bar  
• Incoming Call dialog box Live200 first looks at the General Preferences sheet to see which Address 

Book lists to search. If an Address Book list has not been specified, or if no match is found in an address 
Bookers book list, Live200 checks the Call Preferences tab to see if the User's name option in the 
Identity shown to others group is enabled. If it is, the identity that you specified when you installed the 
software is displayed. If the Other name option in the Identity shown to others group is enabled, that 
name is displayed instead. The name specified in the Other name option is also displayed if the network 
transport you are using for the call does not support Caller ID. You specify how you want the name to 
appear, either full name, first name only, or last name only, in the Conference Preferences tab. 

The following Caller identification preferences are available: 

• The Add button opens a dialog box that lets you select an Address Book list to use for incoming calls. 
By searching an Address Book list, Live200 can provide you with the name and number of your caller 
before you answer the incoming call.  

• The Remove button removes the Address Book lists that you highlight in the list box.  
• The Remove all button removes all Address Book lists that appear in the list box.  

 



Call Preferences 
Click the Call tab to display the Call Preferences sheet, which lets you: 

• Set a dialing prefix  
• Set your computer to automatically answer incoming calls  
• Assign yourself an identity that is shown to others  
• Set the ringer volume  
• Set Dialing Properties  
• Modify how many phone numbers you want listed in the Hotlist menu.  

 

The following Call Preferences are available: 

• The Use dialing prefix check box lets you add a number that is dialed before all phone numbers. If you 
enter that number as the phone number prefix, you do not have to manually dial it before each call. Click 
the Dialing Properties button to open the Dialing Properties dialog box, which lets you set and 
automate dialing prefixes.  

For example, you might have to dial a number, such as 9, before making a call. To use a dialing prefix, 
enter the prefix in the appropriate box. When you make a call, you just dial the 7-digit number and the 
prefix is automatically included. If you are using dialing prefixes, you do not need to enter them when 
you create an entry in an Address Book list. 



 

• The Auto answer incoming calls check box lets your computer automatically answer all incoming 
calls, without you having to be present. You must select this option in order to be controlled as a remote 
desktop. See the Share Preferences section later in this chapter for details.  

• The Ringer Sound Enabled checkbox lets you turn off the ringing signal that alerts you about an 
incoming call.  

• The Ringer volume slider lets you increase or decrease the ringer volume, which rings when you have 
an incoming call. You can adjust the ringer volume for external speakers, such as the multimedia 
speakers or the earpiece, through the Call Preferences tab. You cannot adjust the ringer volume for 
speakers that are internal to the PC. 

• The Identity shown to others group lets you specify how your name appears on the Image Bar during a 
call. If you choose User's name, your name is shown the way you specified it when you installed the 
software. For example, if you entered an identity name during setup of Live200, it appears as the User's 
name. If you choose Other name, you can enter how you want your name to appear.  

Your identity also appears in the Information window of the Whiteboard. Select Information Window 
from the View menu of the Whiteboard application to display this window.  

 

Share Preferences 
Click the Share tab to display the Share Preferences sheet, which lets you set application scrolling and set up a 
computer for remote control. 



 

The following Share Preferences are available from the Sharing applications group: 

• Scroll the shared application on my screen causes the shared application to appear in a window that is 
smaller than the application window. In order to see the clipped off parts of the shared application, it is 
automatically scrolled as you move the cursor near the edges of the window.  

• Scroll the entire screen causes the entire desktop to scroll.  
• Clip off the edges of the application on my screen causes the shared application to appear in a small 

window with the edges clipped off. The Sharing my computer group lets you determine whether other 
callers can share your desktop. If you check Allow callers to access my files and run my application 
callers have access to everything on your desktop. You must set a password to let callers access your 
desktop.Your password can be up to eight characters in length and can include any characters. When 
you enter a password, asterisks appears for security purposes. 

 

The Sharing Interaction group lets you determine whether other callers can interact with shared 
applications. Click Other callers can fully interact with the shared application if you want other 
conference attendees to be able to work in the shared application. Click Other callers can see, but 



cannot interact with shared application if you want other conference attendees to be able to see the 
shared application, but not work in it. 

 

Conference Preferences 
Click the Conference tab to display the Conference Preferences sheet which lets you determine how conference 
attendees' names appear in the Image Bar. You can also specify the folder in which files sent to your Inbox 
during file transfer are saved. 

 

If a match is found for the caller in the Address Book list, the option you select in the Image Bar - How names 
are displayed group appears in the Image Bar. You can choose to display the full name, the first name only, or 
the last name only. The name appears in a tab at the top right corner of the shared application or file, on the 
Image Bar during a conference, and in the Whiteboard Information window. The name must be listed in an 
Address Book list and Caller identification must be supported, otherwise the name you specify in the Identity 
shown to others in the Call Preferences sheet appears.  

You can specify the folder in which files sent to your Inbox during file transfer are saved. The default folder is 
the directory where Live200 is installed. To change this folder, click the Browse button and select another 
folder. 

 



Video Window Preferences 
The Video Window Preferences sheet lets you automatically reposition and size the Local Video and Remote 
Video windows to optimize your videoconferencing desktop. 

 

The following Video Window preferences are available from the Window resizing group: 

• Size for best video image provides an aspect ratio similar to your monitor's aspect ratio for the Local or 
Remote Video windows. The aspect ratio is the relationship between width and height.  

• Permit any size window allows any size for the Local or Remote Video windows. Some video 
distortion might occur when you resize the windows. The maximum resolution of your video image is 
determined by the type of monitor you are using. 

The following Video Window Preferences are available from the Window stacking group: 

• Remote video window always on top keeps other windows from covering the Remote Video window.  
• Local video window always on top keeps other windows from covering the Local Video window. The 

Video window size group provides screen size sliders that let you customize the vertical and horizontal 
measurements of the Small, Medium, and Large selections from the Image listbox in the Local Video 
and Remote Video windows. 

 



Video Windows and Application Sharing 
Placement of video windows during application sharing preferences let you size and position the Local 
Video and Remote Video windows when you start application sharing. For example, if you select Top Left for 
the position of the Local Video window and Top Right for the position of the Remote Video window, these 
windows automatically reposition themselves to the top left and right corners of your screen when you start 
application sharing. 

The following Video Window preferences are available from the Placement of video windows during 
application sharing group.  

The Position listbox has the following choices:  

• Hidden hides the video window so that it does not appear on your screen.  
• Top left displays the video window at the upper left-hand corner of your screen.  
• Bottom left displays the video window in the bottom left-hand corner of your screen.  
• Top right displays the video window in the top right-hand corner of your screen.  
• Bottom right displays the video window in the bottom right-hand corner of your screen.  
• Do not move does not let the video windows move automatically during application sharing.  

The Size listbox has the following choices:  

• Small displays a small-sized window.  
• Medium displays a medium-sized window.  
• Large displays a large-sized window.  
• Unchanged displays the window at the size it was in the previous call. When you stop application 

sharing, the size and position of the Local and Remote Video windows resume to their previous state. 

 

Toolbar Preferences 
The Toolbar Preferences sheet contains the Main toolbar preferences. It lets you create custom toolbars for the 
Main toolbar, the Local Video window toolbar, and the Remote Video window toolbar. 



 

 

Customizing the Toolbars 
To customize the toolbar use the following functions: 

• The Select toolbar listbox lets you select the toolbar to customize. 
• The Button size option lets you determine the size of the toolbar buttons. 
• The Toolbar group contains the buttons that are currently in the Main toolbar. You can add and remove 

these buttons by following the instructions in the next section. 
• The Buttons group contains buttons that you can add to the Main toolbar by dragging and dropping 

them into the Toolbar group.  

 

Spacing between Toolbar Buttons 
You can move, remove, and change the spacing between any buttons on a toolbar as follows: 

• Move a button in the Toolbar group by dragging and dropping it to a new location and clicking Apply.  
• Delete a button in the Toolbar group by dragging and dropping the button outside the group. It then 

appears in the Button group. Click Apply to save your changes.  
• Add a space between toolbar buttons by dragging the button away from another button. Remove a space 

between toolbar buttons by dragging the button toward another button. Click Apply to save your 
changes.  



 

Local Video Window Toolbar 
If you select Local Video from the Select Toolbar listbox the Local Video window toolbar buttons appear: 

 

Remote Video Window Toolbar 
If you select Remote Video from the Select Toolbar listbox the Remote Video Window toolbar buttons appear. 



 

Menu Preferences 
Click the Menu tab to display the Menu Preferences sheet. You can customize Live200 menus so that they 
contain the commands that you use most often. 



 

The following options are available: 

The Available commands group provides a listing of commands that you can assign to any menu listed in the 
Menu group. Commands can be assigned to more than one menu. The Description box gives you information 
about each command.  

• To add a command to a menu, drag the selected item and drop it onto a menu in the Menu list.  
• To remove a command from a menu, drag the selected command off the Menu list and drop it anywhere 

on the screen.  
• Select the Separator to place a horizontal line between menu items. The Menu group provides a list of 

the Live200 Main toolbar menus.  
• You can click on any menu in this listing and edit and rename its text. Click the + (plus) sign to expand 

the submenus.  
• An & symbol (ampersand) indicates the placement of an underbar for a shortcut key. Positioning the 

ampersand to the left of a letter assigns the underbar to that letter.  
• You can move any menu by dragging and dropping it.  

You can delete any menu by dragging and dropping it outside of the group. 



Troubleshooting  
 

Overview 
You can troubleshoot your PictureTel Live200 system using the two types of diagnostic tools provided with 
Live200:  

• The Diagnostics window (for viewing error logs, performing loopback tests, and getting statistical 
information) in the PictureTel Live200 application.  

• The PictureTel Live2Tst Diagnostic application (for testing major circuit elements). The test results 
from these tools help your PictureTel service provider find a solution to a problem. For example, you 
might need a replacement board.You can also contact technical support using any of the methods 
described in the Contacting Technical Support section. 

Click the following links for additional information: 

• Diagnostics Window 
• Error Log 
• Version Numbers 
• Tests 
• Statistics 
• Live2Tst Diagnostic Application 
• Contacting Technical Support 

 

Diagnostics Window 
Choose Diagnostics from the Tools menu in the Main toolbar, or click the Diagnostics button (if you added this 
button to the toolbar) to access the Diagnostics dialog box. This dialog box lets you view errors, run a loopback 
test for testing your Live200 system, view statistics about your system, and check the versions of software you 
are running.  

The functions from the Diagnostics dialog box do not test the major circuit elements in the PictureTel Live200 
system. See the section entitled Using the Diagnostic Application for information about testing circuit elements. 

 

Error Log 
An error log contains a chronological collection of errors that are useful when calling your PictureTel service 
provider. The information in the Error Log sheet is recorded in the ELOGCURR file, which is located in the 
folder in which you installed PictureTel Live200. This file stores up to 100K of information. Once the 100K 
limit is reached, the information in the ELOGCURR file is copied to the ELOGPREV file. This action ensures 
space for new information in the ELOGCURR file. 



You can print or view both of these files using the Windows 95 Notepad or WordPad applications in the 
Accessories folder. 

 

• Filter opens the Filter Error Messages dialog box, which lets you select the type of errors you want to 
display. 

• Save As saves the error log as a file. 
• Clear clears all messages in the error log. 
• Test runs a test to ensure that the error log is working properly. 

 

Version Numbers 
You can get the serial number and version number of any file installed by PictureTel Live200 on your hard 
drive. This information is useful when calling your PictureTel service provider. 

To get serial and version numbers for Live200 file: 

Click the Version tab in the Diagnostics dialog box. 



 

To save the version number information to a .TXT file: 

Click the Save As button in the Version sheet. 

 

Tests 
The Test sheet lets you make a video call to yourself, referred to as a loopback, for video, audio, and ISDN 
testing purposes. 

To access the Test sheet: 

Click on the Tests tab in the Diagnostics dialog box. 



 

• Select a connection type lists the connections upon which you can run a loopback test. 
• Select a test to perform lists the tests from which you can choose 
• Test Results displays the outcome of the test you ran. 
• Start Test runs the test that you selected. 
• Stop Test stops the test you selected from running. 

 

Statistics 
The Statistics sheet lets you view statistics about your Live200 system. When you select an item from the list, 
the Summary statistics box displays the current call information. To refresh the statistic information after it has 
been displayed, click the Refresh Statistics button. 



 

•   Select a connection type lists the connections for which you can display statistics.  
•   Summary statistics displays a summary of the statistics for the connection type you chose.  
•   Statistics details displays the statistic details for the connection type you chose.  
•   Refresh statistics refreshes the statistics fields when you choose a new connection type.  

 

Live2Tst Diagnostic Application 
The PictureTel Live2Tst Diagnostic application is a separate standalone Windows 95 application that lets you 
test major circuit elements. It lets you test the Live200 board for any problems. All data paths and components 
are tested by addressing, reading, and writing registers and memory locations. The physical and functional 
integrity of the PCI bus interface is also tested. 

The Diagnostic application does not test the PictureTel Live200 software or the attached ISDN network. To test 
your PictureTel Live200 software, see the section Diagnostics Window, earlier in this chapter. 

The Diagnostic application performs a pass or fail test of the Live200 board. While it runs, it records all 
messages in an error log file. You can provide your PictureTel service provider with a hard copy of this log 
should your Live200 board need repairing. 

To run the Diagnostic application: 

1. Close all videoconferencing applications, including Live200.  
2. Double-click the Live2Tst.EXE file located in C:\Windows\System\Live200\Diags. 

 
The Live2Tst Hardware Diagnostics dialog box appears. 



 

 

3. Click the Start Testing button. 
 
The diagnostic application tests the major circuit elements of the system, such as the Live200 board. The 
Test Status box lists the name of the current test, and the progress indicator bar displays the percentage 
of the tests completed. You can stop the test at any time by clicking the Stop button. 
 

 

4. Click the Board ID button to get information on the board, such as the revision number, serial and part 
numbers, and last failure. 



 

 

5. Click the Camera Test button to see the video image from the camera. 
 
A camera test window appears which lets you visually check the video image the camera is transmitting. 
Click the Cancel button to close the test window. 

6. Click the Audio Test button to check the speaker and microphone. 
 
The Audio Test window appears. 
 

 

7. Click the Error Log button to view the error log. The log contains a sequential listing for each of the 
tests, including test name and the status of each test. The log is saved as a text file called Errorlog.txt. 
You can print the log using the Windows Notepad application. 



 

 

Contacting Technical Support 
PictureTel's Web page includes information about the PictureTel corporation, products and user groups, as well 
as information about contacting Customer Service. You can also download software updates and patches from 
the web page. Point your browser to: 

http://www.picturetel.com 

Customer Service BBS 

PictureTel's Customer Service Bulletin Board (BBS) is a dial-in BBS that provides Customer Service 
information through a modem. Access the BBS to download files, to perform keyword searches on text or 
software files, and to exchange messages with the system operator. 

System Requirements to Access BBS 

• PC  
• Communication (terminal emulation) software  
• Modem with a minimum 14.4 kbps transmission rate  
• ANSI graphics  
• Multiple transfer protocols  

Accessing the BBS 



To access the PictureTel BBS: 

1. Run the communication software.  
2. Set terminal configuration to (8) data bits, No parity, (1) stop bit.  
3. Dial the following modem number. (If calling from outside the US, add the country code of 1.)  

508-292-3350 
 
When the mode connects, the Welcome screen appears and prompts you for your full name. 

FAX Back 

PictureTel's FAX Back service offers a wide variety of taxes with technical tips and troubleshooting 
information. With a touch-tone phone, call: 

800-783-5411 

Follow the voice prompts to order a FAX back document. 

 



Hardware and Communication Settings 
 

Overview 
You can change your video, audio, application sharing, and network settings and view board information, such 
as revision levels. Some of these settings are automatically set during installation. You can also enable, disable, 
and reconfigure network transports. You might need to consult your network provider when modifying network 
settings. 

Click the following links for additional information: 

• Video Bandwidth 
• Changing Hardware Settings from the Control Panel 
• Changing Hardware Settings in PictureTel Live200 
• Video Settings 
• Video Compression Settings 
• Audio Settings 
• Audio Compression Settings 
• Application Sharing Settings 
• Network Settings 
• Board Info Settings 
• Communication Settings 

 

Video Bandwidth 
The amount of channel bandwidth that is allocated to the video has a great impact on the quality of the video. 
The video transmit bandwidth is determined by the remaining bandwidth after the audio and data portions of the 
call are allocated. Thus, the audio and data bandwidth settings are important in controlling the video quality. 
You can select the audio compression and application sharing formats through the Hardware Settings dialog 
box.  

In a normal office situation, where you are sitting in one position and moving very little, leave the Audio 
Compression setting at the default of SmartPick and the Application Sharing setting at the default of High. 
In a situation where there is motion, change the Audio Compression setting to G.728 by clearing the 
SmartPick check box and selecting G.728 from the Preferred Compression Scheme and change the 
Application Sharing setting to Off. Make sure that other conference attendees' systems are also set to G.728. 

You cannot share an application if you set the Application Sharing setting to Off. 

 



Changing Hardware Settings from the Control Panel 
You can change your hardware settings before running PictureTel Live200 using the Live200 Hardware 
Settings applet in the Control Panel. Changes you make take effect when you run PictureTel Live200. 

To open the Live200 Settings applet: 

1. Click the Start button from the Windows 95 desktop.  
2. Click Settings from the Start menu.  
3. Click Control Panel from the Settings menu.  
4. In the Control Panel, click the Live200 applet . 

 

The Live200 Settings dialog box appears.  

 

Changing Hardware Settings in PictureTel Live200 
You can change your hardware settings when running PictureTel Live200. Changes you make take effect the 
next time you start PictureTel Live200 or in the next call. 

To open the Hardware Setting dialog box in PictureTel Live200: 

Choose Hardware Settings from the Tools menu in the Main toolbar or click the Hardware Settings 
button (if you added this button to the toolbar).  

The Hardware Settings dialog box appears with the Video sheet displayed.  

 

Video Settings 
Click the Video tab to display the Video sheet. The controls in this sheet let you adjust your video camera 
settings, which you can preview in the Local Video window. 



 

The following options are available in the Picture Controls group: 

• The Brightness control slider lets you adjust the balance of light and dark shades of your image in the 
Local Video window. You can adjust the brightness level during a video call.  

• The Color control slider lets you adjust the color mixture of your image in the Local Video window. 
You can adjust the color level during a video call.  

• The Contrast control slider lets you set the range between the lightest tones and the darkest tones of 
your image in the Local Video window. You can adjust the contrast level during a video call.  

• The Preview button lets you temporarily see the changes you make by displaying the Local Video 
window.  

 

Video Compression Settings 
Click the Video Compression tab to display the Video Compression sheet. PictureTel Live200 compresses 
video signals so that they can be sent over ISDN phone lines. The signals are decompressed at the receiving end 
and presented as full-motion video. For the settings to take effect immediately, adjust the Video Compression 
Quality slider before making a video call. 



 

The settings for the Video Compression Quality slider determine the video quality that you transmit to other 
conference attendees. This control does not affect the video quality that you receive. 

• Dragging the slider towards Smooth Motion increases the smoothness of the frame transmission rate for 
the video. When the slider is in the left two positions video is transmitted in in Quarter Common 
Intermediate Format (QCIF). QCIF provides a video resolution of 176 by 144 lines.  

• Dragging the slider toward Sharp Picture increases the detail in a single video frame, which sharpens 
the video resolution. When the slider is in the right two positions, video is transmitted in Common 
Intermediate Format (CIF). CIF provides a video resolution of 352 pixels in each of 288 non-interlaced 
lines.  

• The Preview button lets you temporarily see the compression quality by displaying the compressed 
video in a window. When you click the Preview button, the message "Starting Preview" appears. The 
window appears with a preview of your image. When you are finished adjusting the compression 
settings, click the Close button to close the window.  

 

Audio Settings 
Click the Audio tab to display the Audio sheet. These settings affect the sound that other conference attendees 
hear. 



 

The Audio Input Device is initialized during installation. The default setting for this category is Auto. 

• Click Auto to have the system automatically detect your audio device.  
• Click Microphone if your audio input device is a microphone. For example, you can use the earpiece or 

external microphone that is packaged with PictureTel Live200, or a microphone from another 
manufacturer.  

• Click Other if your audio input is not a microphone. For example, you can use the line-out connection 
from a PictureTel speakerphone, CD player, VCR, or cassette player. The Ring Output is initialized 
during installation. The default setting is Internal Computer Speaker. 

• Click Live200 Earpiece or Speaker if you want the ringer to sound from the earpiece or multimedia 
speakers that are packaged with PictureTel Live200.  

• Internal Computer Speaker sends the ringer to the internal speaker in your computer. This option does 
not support built-in multimedia speakers. You can adjust the ringer volume for external speakers, such 
as the multimedia speakers or the earpiece, through the Call Preferences tab. You cannot adjust ringer 
volume for speakers that are internal to the PC. 

The following options in the Smart Features group are turned on by default: 

• The Noise Reduction check box filters our certain background noises, such as the noise from air 
conditioners or ventilation systems.  

• The Automatic Gain Control check box lets the system keep the input speech signals from the 
microphone at a constant level. For example, when you back away from the microphone, the other 
conference attendees detect no difference in volume.  

 



Audio Compression Settings 
Click the Audio Compression tab to display the Audio Compression sheet. 

PictureTel Live200 compresses audio signals so they can be sent over ISDN phone lines. The signals are 
decompressed at the receiving end and converted into sound. 

 

The following options are available: 

• Click the Smart Pick checkbox to have PictureTel Live200 use the best audio compression method 
based on the other conference attendee's audio configuration.  

• If you want to select the compression method yourself, the Preferred Compression Scheme listbox 
provides the following choices:  

• PictureTel PT724 is a PictureTel standard scheme that can only be used with PictureTel products. It 
producers high-quality, 
wide-band audio using minimum bandwidth. The bandwidth requirement for this scheme is 24 kilobits 
per second. The frequency range is 50 to 7,000 Hz.  

• ITU-T (International Telecommunications Union - T) Rec. G.711 A-law is a European standard that 
provides telephone-quality audio. The bandwidth requirement for this scheme is 64 kilobits per second. 
The frequency range is 300 to 3,400 Hz.  



• ITU-T Rec. G.711-V-law is a North America standard that provides telephone-quality audio. The 
bandwidth requirement for this scheme is 64 kilobits per second. The frequency range is 300 to 3,400 
Hz.  

• ITU-T Rec. G.722 is a standard that provides the highest quality wide-band audio. Not all 
videoconferencing systems support this scheme. The bandwidth requirement for this scheme is 48 to 56 
kilobits per second. The frequency range is 50 to 7,000 Hz.  

• ITU-T Rec. G.728 is a standard that provides telephone-quality audio using the least amount of 
bandwidth. Not all videoconferencing systems support this scheme. The bandwidth requirement for this 
scheme is 16 kilobits per second. The frequency range is 300 to 3,400 Hz. The Lip sync option lets you 
determine whether audio and video are synchronized. For example, there is usually a slight delay 
between the sound you hear and the image you see. If you choose Enable Lip sync, you hear the audio 
at the same time you see the image. If you choose Fast Audio, you hear the audio as soon as possible, 
even if it is out of sync with the video. 

When you make an audio-only call, G.711 audio compression is used.The default voice coding is 
automatically set based upon the ISDN protocol being used. You can override the default by choosing 
one of the following Default voice coding options: 

• A-law - This is the preferred mode for calling in most European countires.Typically, most countries 
using the PAL video standards use A-law.  

• mu-law - This is the preferred mode for calling in North America and some parts of Japan. Typically, 
most countries using the NTSC video standards use mu-law.  

 

Application Sharing Settings 
Click the Application Sharing tab to display the Application Sharing sheet. 



 

You determine how much bandwidth you want to use for the data sharing portion of your conference and 
whether you want that bandwidth to be fixed or to change. If you allocate a high amount of bandwidth for data, 
there is a quick response in the data sharing portion of the conference. However, the more bandwidth you 
allocate to data the less that is available for video, which affects the quality of the video image. If you do not 
use data sharing, set the rate to Off. If you are using data sharing, it is recommended that you keep the rate at 
the default of High for the best response time. 

You also determine whether you want the bandwidth allocation to remain fixed or to change throughout the 
conference. If you want the rate to remain at the setting you choose, keep the Control method at the default of 
Static. When you choose Dynamic, the bandwidth for data changes depending on its use. When you are not 
sharing data, the bandwidth is given to the video portion of the conference; when you share data, the bandwidth 
is given back to the data sharing potion of the conference.The amount of available bandwidth is determined by 
your choice in the Maximum rate group. 

 



Network Settings 
Click the Network tab to display your ISDN settings. Your network administrator or telephone company can 
provide you with the information needed for this sheet. 

 

If you have installed another network interface on your Live200 system, such as the V.35/RS-449 Data-Dialer 
Module (DDM) or First Virtual Asynchronous Transfer Mode (ATM), you can choose those interfaces by 
clicking the arrow in the Network selection listbox. 

Select the ISDN protocol that you want to use in the Protocol listbox. 

 



Your choices are as follows: 

• 5ESS Point-to-Point refers to the operation of one device on an ISDN line. With this service, only a 
single communications device is used for each BRI (Basic Rate Interface) line. This protocol is the 
default setting.  

• 5ESS Multipoint refers to the operation of multiple communications devices on an ISDN line. Service 
from a 5ESS Multipoint switch has one Service Profile Identifier (SPID) number.  
 
A SPID is a number assigned by your telephone company to each device connected to your ISDN line. 
SPIDs lets the telephone company know which ISDN services a given device can access. 
 
When you choose this protocol, the Channel One and Channel Two SPID boxes appears. These 
SPIDs are used to identify a specific ISDN set when more than one set has been attached to the same 
central office (CO) line. Your ISDN service provider can give you the SPID number. Do not use 
punctuation or spaces between digits when you enter the SPID. Make sure that you enter the SPID 
numbers correctly or you cannot make or receive calls. 

Select one of the following protocols if you are connected to a public network: 

o Net-3 for Norway  
o Net-3 for Singapore  
o Net-3 for Italy  
o Net-3 for Switzerland  
o Net-3 for Taiwan  
o Euro-ISDN  

 
When you select a Net-3 or Euro-ISDN protocol, the following sheet appears: 



 

The following options are available: 

The Multisubscriber No. 1 and Multisubscriber No. 2 (MSN) are for those switches outside the 
United States and Canada that permit multiple computers, each with a unique set of ISDN phone 
numbers, to be connected to a single line. To allow PictureTel Live200 to respond only to those 
incoming calls that are intended for your system, you must specify the MSNs that differentiate your 
system from other computers attached to the ISDN line.  

Number Type provides Unused, International, National, Network Specific, and Subscriber selections.  

Number Plan provides Unused, ISDN, Data (x.21), and Unknown selections.  

• NI1, DMS100  

If you choose NI1 or DMS100 the Channel One SPID and Channel Two SPID boxes appear. Service 
from these protocols have two Service Profile Identifier (SPID) numbers. The SPIDs are used to identify 
a specific ISDN set when more than one set has been attached to the same central office line. Your 
ISDN service provider can provide you with the SPID numbers. Do not use punctuation or spaces 
between digits when you enter the SPIDs. Make sure that you enter the SPID numbers correctly or you 
cannot make or receive calls. 

• NTT (Nipon Telephone and Telegraph)  

Select a number from the Number Type listbox. The numbering type is used for all calls. The type you 
choose is determined by the type of service you have. Your choices are as follows:  



• Unknown  
• International  
• National  
• Network Specific  
• Subscriber  
• Unused  

Select a number plan from the Number Plan listbox. The numbering plan is used for all calls. This plan 
is determined by the type of service you have. You can obtain this information from your ISDN service 
provider. Your choices are as follows:  

• ISDN  
• Data (x.121)  
• Unknown  
• Unused  

Channel One MSN and Channel Two MSN (Multiple Subscriber Number) boxes appear. MSNs are 
for those switches outside the United States and Canada that permit multiple terminals, each with a 
unique set of ISDN phone numbers, to be connected to a single line.  

• TPH1962  
• VN-3  
• 1TR6  

Select a number from the Number Type listbox. The numbering type is used for all calls. The type you 
choose is determined by the type of service you have. Your choices are as follows:  

• Unknown  
• International  
• National  
• Network Specific  
• Subscriber  
• Unused  

Select a number plan from the Number Plan listbox. The numbering plan is used for all calls. This plan 
is determined by the type of service you have. You can obtain this information from your ISDN service 
provider. Your choices are as follows:  

• ISDN  
• Data (x.121)  
• Unknown  
• Unused  

 



Board Info Settings 
Click the Board Info tab to display the settings for your Live200 board. This information can be useful if you 
need to call your PictureTel service provider. 

 

 

Communication Settings 
The Communications dialog box lets you enable, disable, and reconfigure network transports. You must enable 
ISDN to make video calls. You can select another transport to make a data only call. For example, you might 
want to share an application with someone who does not have an ISDN line. Both you and the other conference 
attendee would select the transport that you have in common. 

To open the Communications dialog box: 

Click Communications from the Tools menu in the Main toolbar or click the Communications button (if 
you added this button to the toolbar).  

The Communications dialog box appears with the Modem sheet displayed. 



 
If you have a modem in your computer you can use it to make data only calls by clicking the Enable 
communications box. Click the Change Modem Settings button if you need to make adjustments to 
your modem settings. 

If your computer is configured with the NetBIOS, IPX, or TCP/IP transport, you can use those transports to 
make data only calls by clicking the appropriate tab, clicking the Enable communications box, and typing your 
address in the address box. You can click the Change Network Settings button to open the Windows 95 
Network Properties dialog box and make changes to your network settings. 

You can enable the GroupShare transport if you want to make and answer calls through a PictureTel group 
videoconferencing system, such as the Venue·2000, Concorde·4500, or SwiftSite. This adds data sharing 
capabilities to the group videoconferencing system.  

To use this transport, your Live200 system must be physically connected to the group videoconferencing system 
and the system must be configured to work with the Live200. See the PictureTel Live200 Installation Guide for 
instructions on how to physically connect Live200 to a group videoconferencing system. 

You select the COM port used to connect the Live200 to the group videoconferencing system and set the baud 
rate to match the baud (data) rate of the LiveShare Plus option on the group videoconferencing system. 

If you need to make changes to your ISDN settings, click the ISDN tab. Make sure Enable 
communications is checked, so you can make video calls. When you click the Change Network Settings 
button, the Network sheet appears. See the section earlier in this chapter or the online help for more 
information on the Network settings sheet. 

 



Terminology 
 

Overview 
The following key terms explain the main aspects of Live200. The online glossary defines other terms that are 
useful in understanding Live200 functionality. You can access the online glossary from the online Help. 

Click the following links for additional information: 

• Videoconference 
• Data Conference 
• Networks and Protocols 

 

Videoconference 
• Conference attendees are the users whom you call or who call you for a conference.  
• Multipoint videoconferencing lets conference attendees using H.320-compliant conferencing systems 

see and talk to each other. All of the attendees dial into a bridge, which hosts the conference.  
• Bridge is a software-controlled switching device that interconnects multiple H.320-compliant 

videoconferencing systems. The term Multipoint Control Unit (MCU) is also used. To join a multipoint 
video conference, you and the other conference attendees dial into a bridge at a pre-arranged time.  

• Local Video window displays the image you are sending to other conference attendees. You can adjust 
the brightness, contrast, and color of your image.  

• Remote Video window displays the image you are receiving from other conference attendees. The 
Remote Video window also lets you share applications with other conference attendees.  

• Address Book lets you store, group (address book lists), and dial frequently called numbers.  
• Address book list is an individual database in the Address Book that contains names, phone numbers, 

and locations. You can share address book lists with others.  
• Hotlist lets you create a speed-dial list of your most-frequently dialed phone numbers.  
• Call log list lets you view a list showing the history of incoming and outgoing calls.  

 

Data Conference 
• Multipoint data conferencing lets conference attendees using 

T.120-compliant conferencing systems share applications, such as a Whiteboard, Clipboard, or any 
Windows 95 application. You can also simultaneously transfer files to all conference attendees.  

• Application Sharing lets you and other conference attendees pass application control back and forth 
and edit the same file within the original application. Only one attendee needs to have the application on 
their computer and all other attendees can share it. All changed files are saved on the originating 
computer.  

• Application Unsharing is when you stop sharing an application. The application disappears from the 
desktops of the other conference attendees.  



• Working Alone is when you disable application sharing while retaining your view of open applications. 
Working alone suspends the application sharing link, and lets you and other conference attendees work 
independently.  

• Whiteboard is a visual workspace that you and other conference attendees can simultaneously use to 
annotate a word processing document or a presentation. Editing is accomplished using a pen, 
highlighter, and a text tool. The Whiteboard scan feature lets you place images from TWAIN-supported 
scanners and video capture devices into the Whiteboard.  

• File transfer lets you transfer files in the background between you and other conference attendees.  
• Messaging lets you record the events of your call to distribute to colleagues, or send messages (also 

known as chat) to other conference attendees.  
• Controlling a Remote Desktop lets you remotely access the any PictureTel product running LiveShare 

Plus. You can also access your office computer from your home computer when they are both connected 
by Live200 videoconferencing.  

• Shared clipboard lets you share your Clipboard so that you and other conference attendees can copy, 
cut, and paste information to make it easily available to each other.  

• TWAIN is a software industry standard that allows software applications and hardware imaging devices 
to communicate directly. Live200 is a TWAIN-compliant application, which means it can be used with 
other TWAIN-compliant imaging devices.  

 

Networks and Protocols 
• Integrated Services Digital Network (ISDN) is a telecommunication standard that is capable of 

sending digitally encoded voice, data, video, and other signals on the same lines.  
• Basic Rate Interface (BRI) is an interface between a user and an ISDN switch. The BRI specifies two 

64-kilobit per second (kbps) B channels (for voice and data) and one 16-kbps D channel (for customer 
and call information).  

• Internetwork Packet Exchange (IPX) is a network layer protocol responsible for addressing and 
routing packets to nodes on other networks.  

• Local Area Network (LAN) is a short-distance data communications network used to link together 
computers and peripheral devices, such as printers. Each computer on a LAN is equipped with a network 
adapter board and is connected to the network by a cable. A LAN allows users to share applications, 
data, and peripherals across the network.  

• Modem is a communications device that transmits signals over analog or digital telephone lines.  
• Network Basic Input/Output System (NetBIOS) is a network communications protocol that allows 

computer applications and devices to communicate over a LAN.  
• GroupShare is a PictureTel software application that incorporates the necessary network transports 

required to make a call through a PictureTel group videoconferencing system.  
• Plain Old Telephone Service (POTS) is the basic telephone service with a standard telephone, 

telephone line, and access to the public switched network.  
• H.320 is an international standard published by the International Telecommunications Union (ITU) that 

defines how video, audio, and other data should operate over a switched digital network.  
• T.120 is a collection of data-oriented conferencing specifications published by the ITU. These 

specifications, which have been under development for several years, enable vendors to create 
compatible products for multi-player gaming, multi-user applications, and multipoint data conferencing.  
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